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Introduction
Non-destructive editing is one of the capabilities that distinguishes the HDR24/96
from your old tape recorder. It’s easy, it’s fun, and you won’t cut your fingers
learning how to do it. This guide will introduce you to the editing tools and
concepts.

All the editing operations are performed on screen through the Graphical User
Interface (GUI), so all the discussion in this section applies to GUI operations and
displays only. See page 13 of the Quick Start Guide for details on installing a
monitor, mouse and keyboard.

Once you are ready, sit down in front of your screen, take a deep cleansing breath,
reach for the mouse and let’s get started.

Regions
Regions are graphic representations of audio files — or portions of audio files —
stored on the hard drive. The HDR24/96 editor displays regions as boxes within a
track, each containing a waveform display of audio. It’s important to understand
the difference between regions — which just represent audio — and the actual
audio files: A region is information which tells the player at what time, relative to
the start of the audio file, to start playing a portion of the audio file, and when to
stop playing.

After a recording pass, a new region appears along a track, representing the new
audio file in its entirety. The region’s start and stop times are the same as the
beginning and end of the audio file. From this point, the region can be chopped up,
moved, copied & pasted, transferred to other tracks and more; completely
changing the song as it is heard, but without changing the original corresponding
audio file. Each piece becomes a new region, with new information as to where
along the audio file to start playing and where to stop.

If a region is deleted, it won’t play back (because there’s nothing telling the
HDR24/96 when to start playing the file) but its corresponding audio data is still
on disk. Even if all its regions are deleted, the audio file remains. That audio file
can be called back as a new region or erased from the disk.

If you’ve laid some tracks that you really don’t want disturbed, right-click on their
regions and select Lock from the pulldown menu.

An editing note regarding regions within Virtual Takes: Each track can contain up
to seven inactive virtual takes. These are safe from global editing operations only
when the tracks are collapsed so that only the active take is visible. If you are
performing global selections and chopping and plopping regions here’n’there,
make sure that only the virtual take that you want chopped is visible. Select it as
the active take, then collapse the track to keep the others safe from this Borg type
activity.
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Your tool kit includes the I-Beam, Hand, Volume Envelope, and Magnifier tools.
The Scrub wheel isn’t really an editing tool, but it’s grouped on screen with them
because it interacts with the Hand and I-Beam tools, and it’s handy for locating
edit points.

An editing tool is selected by clicking on its button. Alternately, right-clicking in
the track area of the screen brings up a pop-up menu with a Tools option. Select
Tools, then select the tool you want. By using the pop-up menu to change tools,
you’ll keep your eyes and mouse hand right where you’re working.

There are keyboard shortcuts for the editing tools, which will help you to keep
your eye on the ball, and your nose to the grindstone:

T – Toggles between the I-Beam and Hand tools.

F1 – Selects the I-Beam tool

F2 – Selects the Hand tool

F3 – Selects the Volume Envelope tool

F4 – Selects the Magnifying tool
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Selection
Area Selection (I-Beam Tool)

The I-Beam tool is used to mark the start and end times of an area for editing
operations. It operates on a single track, a group of selected tracks, or all the
tracks.

Clicking and dragging the I-Beam across a track selects an area. The same
selection can be made on all tracks by clicking and dragging the I-Beam
across the time bar.

Once an area has been selected, the area boundaries and its position can be
adjusted in several ways:

• Placing the I-Beam cursor on either edge of a selection boundary turns
the cursor into a double-headed arrow. When this arrow appears, click
and drag the edge of the selection to move it. The selection boundaries
can also be dragged from the time bar at the top of the track area. The
selection is marked on the time bar by a gray band with its upper
corners darkened. Those dark corners are “handles” by which you can
drag the selection ends.

• CTRL-click on the Selection Range Start or End time field to capture
the current transport time into that field. This can be done either with
the transport stopped or while playing, to select an area on the fly.

• The entire selection (at its present length) can be repositioned by
dragging the gray area on the time bar.

Multiple Area Selection

To make the same selection on multiple tracks, after an area is selected on
one track, CTRL-click anywhere in another track’s area to duplicate the
selection on that track. Shift -clicking on another track will duplicate the
selection on all the tracks between the first one selected and the one on
which the mouse pointer is clicked.

Selection Range Display

The Selection Range Start and End time
fields in the Tools panel show start and
end times of the area currently selected
via the I-beam tool. This time display is
interactive with the selected area. The
area boundaries can be updated by
editing the numbers in the time fields.
Conversely, as the selection boundaries
are changed by dragging with the mouse,
the time fields are updated.
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Click on the desired field in the Selection Range display to highlight the pair
of digits you wish to modify. Change the numbers by dragging the mouse up
or down over the highlighted digits or with direct numeric entry from the
keyboard. Navigate between hours, minutes, and seconds fields with the Tab
or Shift-Tab  key or mouse. Complete the data entry with the Enter  key
or by clicking in the Tools panel background area.

NOTE: If you manually enter a Start time which is later than the current End time,
the later time becomes the selection End time, and what was the former End time
becomes the new Start time.

Region Selection (Hand Tool)

The Hand tool is used for selecting (grabbing), moving, and resizing regions,
plus changing fade-in and fade-out curves. The Hand tool works on single or
multiple regions, so it’s possible to move or resize a group of selected regions
at one time. This is particularly handy for stereo tracks, or all of the drum
kit’s tracks.

A region is selected for editing by clicking anywhere in the region with the
Hand tool. The Hand tool’s function changes, depending on where it’s placed
in the active region area, with its cursor shape changing to indicate its
current function. Placing the Hand Tool cursor on either end boundary and
above a region’s centerline activates the fade adjustment tool. Below the
region’s centerline the cursor becomes a resizing tool. Within the region
boundaries, the Hand Tool’s hand cursor is used for dragging the region.

A region or regions (selected as group) may be dragged around with the Hand
tool and dropped on top of blank track area, on top of other regions or a little
bit of both. The Splice and Crossfade functions affect the way a region will
intersect or overlay another region.
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Multiple Region Selection

Multiple regions can be selected and operated upon as a group (moving,
deleting, resizing, or changing crossfades) by CTRL-clicking on each region
of the desired group with the hand tool.

Double-clicking on a track number selects all the regions in the active take of
that track. If the track is expanded to show virtual takes, double-clicking on
any take number selects all the regions in that take, but does not change the
active take.

CTRL+A selects all regions in the project.

Magnifier

The Magnifier tool expands and contracts the region and track displays, allowing
you to take a closer look at the waveform on a track and zero in on your selection.
Single clicks with the Magnifier tool selected expand the track display
horizontally. Dragging the Magnifier across tracks and regions draws a box and
zooms the selected area both vertically and horizontally, like a magnifying glass.
CTRL-clicking with the magnifier tool active zooms out.

The “Dive” Key (Z)

The ‘Z’ key operates as a momentary zoom-in key for a high resolution view
around the current cursor position. Releasing the Z key returns to the
previous screen view.

Node Tool

The Node tool allows adjustment of the volume level within a region (which could
be the entire track). For details on using it, please see page 16.

Cursor Location Display

This time display tracks the current time location of the cursor pointer, regardless
of the selected tool. It is a display function only.
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This tweak tool set allows you to nudge selected regions, areas, or area selection
boundaries. Actions include moving regions, resizing regions, moving or resizing
region attributes (such as start, end or length) in specified time increments.
Multiple regions and region attributes may be selected and modified in the same
manner as single regions. Nudge tools are located on the Tools panel, just to the
right of the Selection Range time displays.

Nudge Resolution

The pulldown menu above the nudge tools selects the increment of one
“nudge” (a small amount of movement) in units of samples, SMPTE frames,
or fractions of a second.

Nudge arrows

The arrows surrounding the three Nudge Selection boxes nudge to the right
or left by the increment selected. What gets moved is determined by which
Nudge Selection box is selected.

Selection Start (left), Selection End (right), Selection (center) boxes

These three boxes select whether the left boundary, right boundary, or the
entire selection or region will be nudged. These are “radio buttons” - only one
may be active at a time. When the Hand tool is selected, the boxes contain a
waveform icon, indicating that a region will be nudged. When the I-Beam tool
is selected, the boxes show a divided block, indicating that a selection will be
nudged.

Selecting the left box causes the left boundary of the selection or region to be
nudged when the left or right arrow is clicked. Similarly, selecting the right
box and clicking on an arrow will nudge the right boundary in the direction of
the arrow. Selecting the center box causes the complete region or selection
area to be nudged when a direction arrow is clicked, without changing its
length.

I-Beam (Area) Nudge
(Nudge the selection area of the region)

Hand Tool (Region) Nudge
(Nudge the region itself).
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Scrub Wheel

The Scrub Wheel tool is the round wheel at the right-hand end of the group of
editing tool buttons. Its function is similar to “rocking the reels” of a reel-to-reel
tape deck. Scrubbing allows playback at slow speed, even in reverse, to locate an
edit or punch-in point the old fashioned way - by ear. The Scrub function is
engaged by clicking on the Scrub Wheel button to highlight it. The S key
momentarily activates the Scrub tool, turning it off when you release the key.

When Scrub is engaged, clicking and dragging the mouse pointer horizontally
along the Marker Bar at the top of the track screen starts the transport playing on
all 24 tracks. Dragging it to the right plays forward, dragging it to the left plays
backward. The mouse acts as a throttle - the further you drag it, the faster the
transport plays, up to full speed. By using a side-to-side motion with the mouse
and listening to the playback, you can zero in on a point in the track that you’re
trying to locate.

If you want to scrub just a single track, with the I-Beam and Scrub tools both
active, place the cursor on the track you want to hear, then click, and scrub.

Caution: Selecting the Scrub tool does not automatically deactivate the Hand
tool. If you scrub on a region with the hand tool active, you won’t scrub, you’ll
move the region.

Edit Clipboard

Cut, copy and paste editing operations are performed through the Clipboard. The
HDR24/96 clipboard follows the conventions common to word processors and
other computer-based editing tools. The editing clipboard buffer holds the result of
a single cut or copy operation (which could be performed on multiple items if
selected). The cut or copied section remains on the clipboard until replaced by the
next cut/copy operation.

For example, if two region Copy operations are performed successively, only the
second selection copied remains on the clipboard, with the first copied selection
going into the bit bucket to make room for the second. As long as a copy remains
on the clipboard, it may be pasted any number of times and to any location.

Each cut and paste operation is recorded on the History list. This possibly very
long edit list is retained only as long as the Project file is open.

History List Entries

With the history list, editing isn’t like heart surgery –
the History list offers a safety net to undo any series
of editing operations. The History List is discussed in
detail in the List Panel section of the Technical
Reference Guide. It’s important to mention here
because the history that’s listed, in addition to
recording passes, is that of all of your editing
operations. It’s the key to nondestructive editing. By
deleting entries from the History list, you can undo
any editing operation.

The following activities are recorded in the History
List and may be undone as long as the list remains
active for the project: Record pass, split, crop, cut,
copy, paste, move region(s), resize a fade-in, resize a
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is region Envelope modifications – node additions, movements or erasure.

Note: Backing up to or prior to a Record pass in the edit list is destructive. If you
undo a Record pass, you can’t recover that recorded audio, nor can you redo any
editing operations that followed the Record pass on the list.

Cut

Cut removes the current selection (on one or multiple tracks) from the track area
and places it on the clipboard. You can Cut either an area selection made with the
I-Beam tool (on one or multiple tracks) or a region selected with the Hand tool.
Cut works contiguously across empty track space in the selected area – i.e.
unrecorded sections within the selected area are placed on the clipboard along
with recorded audio in the selected area. If pasted elsewhere, the pasted section
will include the blank spaces.

The Cut command is accessible from the pulldown Edit menu at the top of the GUI
screen, or by clicking on the CUT button on the Tools panel. The keyboard
shortcut is CTRL+X.

Delete

The keyboard Delete  key is slightly different than Cut. It indeed cuts, but it does
not place the cut segment on to the clipboard. After a Delete operation, the
clipboard retains its previous contents. Delete is entered on the History List, so it
can be undone.

Copy

The Copy command copies the selection(s) or selected region(s) from the track
area to the clipboard. A region or selection is unaffected by a Copy operation. It
remains where it was. Like Cut, Copy works contiguously across empty track
space in the selected area – i.e. empty track space which is included in the area
marked for copying is placed on the clipboard along with areas of recorded audio.
If pasted elsewhere, the pasted section will include the blank space.

The Copy command is accessible from the pulldown Edit menu at the top of the
GUI screen, or by clicking on the COPY button on the Tools panel. The keyboard
shortcut is CTRL+C.

Paste

Paste places the current contents of the clipboard into the selected track,
beginning at the Current Time line. When multiple regions are pasted in, the
relative time between the regions remains intact, with the start of the leftmost
(earliest) region to be pasted falling on the Current Time line.

The Paste command is accessible from the pulldown Edit menu at the top of the
GUI screen, or by clicking on the PASTE button on the Tools panel. The keyboard
shortcut is CTRL+V.
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Paste Repeat

The Paste Repeat operation is used in a similar fashion to Region looping (see
page 20). It works the same as Paste except that the Paste operation is repeated
automatically for a specified number of times, and at a specified interval. The
Paste Repeat function can include multiple regions and silent space in between
regions, whereas the Loop Region operates on one region only. The default Paste
Repeat interval is the length of the selection so that the pasted regions are placed
end-to-end, but this can be edited from the Paste Repeat dialog box.

Splice Mode

The SPLICE button, located near the center of the Tools panel, affects how cut
and paste operations are performed. It’s analogous to tape splicing, hence its
name. If Splice is turned off, cutting a selection out of a region leaves a hole,
perhaps to be filled by an equivalent part from an alternate take. If Splice is
turned on, the two sections on either side of the cut are automatically joined
together by the Cut operation. The earlier section of the region stays put and the
later section (everything to the right, even if there are several regions) slides
forward in time to join it.

When pasting, if Splice is off, the pasted-in section is simply plopped down on top
of the existing region, replacing what was there. If Splice is on, the old track is
divided at the point where the section is pasted, and slides over to make room for
the pasted-in piece.

With Splice off, when multiple regions with a gap (no audio) between them are
pasted to another track, only sections where there is recorded audio will overwrite
what’s existing on the track. In other words, audio existing on the pasted-to track
will be audible in the gaps between the newly pasted regions. If Splice is enabled,
gaps in the pasted-in regions will remain. This is consistent, since the original
track moves out of the way to make room for the spliced-in section, leaving a
space with no audio to poke through the holes.

NOTE: SPLICE only works with clipboard (cut and paste) operations. It doesn’t ap-
ply when dragging a region to a new location with the hand tool.

Snap and Snap-to Functions

When Snap is enabled, dragged objects such as regions or selection lines no
longer move smoothly, with seemingly infinite resolution. Instead they snap to
fixed time increments with magnetic allegiance - i.e. they move smoothly, but
when a virtual (and invisible) grid line is crossed, they stick briefly so you’ll know
you’re in line time-wise with the snap grid. Regions, region boundaries, and
selection boundaries are all affected by the Snap function.

Whenever Snap is enabled, the Current Time bar is also the “snap-to” point, even
if it’s between snap grid lines.

Snap Enable

The Snap controls are found under the Options pulldown menu or from a
menu which pops up when right-clicking on the time bar. Snapping is turned
on or off by clicking on the SNAP button in the Drag/Edit section of the GUI
Tools panel or by selecting Enable Snapping in the Options or pop-up menu.
From either menu, you can select Snap to Grid, Snap to Cues, or both. You
can also select the grid resolution from another pulldown under this menu.
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must select this. It is not sufficient to select Snap to Cues or Snap to Grid by it-
self. If Snapping is enabled with Cues and Grid turned off, a dragged region will
snap to the current time bar or the edge of an adjacent region.

Snap to Grid

The resolution of the grid is set from the Snap Grid submenu. There are both
time (minutes, seconds, frames) as well as musical (bar, quarter note, eight
note, etc.) increments which can be selected as grid increments. In addition,
you can snap to Ruler Marks, which are the divisions along the time bar at
whatever the current time scale is. This option is helpful for working within
the context of the current view - for fine snap increments while zoomed in and
for larger increments when zoomed out.

Time Snap resolutions are as follows:

Minutes

Seconds

Frame

For musical applications (when working in bars beats and ticks) a tempo map
can be imported from a Standard MIDI file, so that snapping to musical
intervals follows tempo changes in the song. If the project is at a fixed tempo
throughout (disco lives!), the tempo from which BBT is calculated can be set
from the MIDI Setup menu. The default tempo is 120 BPM, with a fixed
resolution of 480 ticks per quarter note. The BBT snap resolutions are as
follows:

Bar

Half note - snap to this resolution

Half Note triplet

Quarter note

Quarter note triplet

Eighth note

Eighth note triplet

Sixteenth note

Sixteenth note triplet

Snap to Cues

When Snap to Cues is enabled, the snap function will allow dragged objects
and selections to ‘cling’ to any nearby Cue time.
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Region Manipulation Tools and Functions
The I-Beam and Hand tools are used to redefine and adjust the Start or End of
regions. As a reminder, the start and end points of the region that you see on the
screen may not necessarily be those of the original audio file.

Split

The audio editing process involves cutting large chunks of audio into small pieces
and rearranging those pieces in creative ways. The Split function is used to chop
a region (typically starting with a recording pass) into pieces for editing.

The SPLIT button is located along the bottom of the GUI tools panel. Split can
also be accessed from the Edit pulldown menu, however the choice will be grayed
out unless there’s a marked area or the Current Time bar is bisecting a region – in
other words, the option is only available when there’s something to split.

To divide a region, place the Current Time bar at the desired split point and click
on the SPLIT button. You now have two regions. If you select an area within a
region using the I-Beam tool, SPLIT creates three regions, one consisting of the
selected area, one before the selected area, and one after. Each region carries the
name of the track and take. Renaming the pieces using the Region Editor will help
you to keep track of those little bits of virtual tape for later use.

Splitting follows all the rules of selection. If multiple selections are made, they’ll
all be split with a single command.

Crop

Crop operates in conjunction with a selected area within a region, deleting
everything in the region that is outside of the selection. It follows the selection
rules so a single Crop command will crop multiple tracks with defined selections.
Since there must be something useful left after cropping, Crop only functions on a
selection width of 1 frame or greater.

CAUTION: Be careful when cropping. Crop operates on both sides of the selected
area. If your intent is to chop off the beginning of a region but not the end, be
sure your selection area extends safely outside the region boundary on the end
you want to keep.

The CROP button is located along the bottom of the GUI tools panel. It can also
be accessed from the Edit pulldown menu when an area is selected.

Moving Regions - Click’n’Drag

With the Hand tool active, you can click on a region and drag it anywhere in the
track area. This is, in essence, a combination of the copy and paste commands in a
single operation. There are a couple of variations:

CTRL-click when dragging combines Copy and Paste operations, leaving the
region in its original place and putting a copy elsewhere in the track area.

Shift -click when dragging allows you to move a region, but constrains it in
time. It can move vertically (to another track or take) but can’t move horizontally.
This is particularly useful when building a composite track from multiple takes. It
keeps things locked in time (of course you can do fine adjustments later).
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constrained copy of the selected region is place on another track without
disturbing the original regions.

NOTE: Copying in this manner does not place the copied segment on the Clip-
board. Like the Delete key, the Clipboard retains its original contents.

Insert Time

Insert Time inserts a specific amount of blank space into the selected Track(s). It
is a combination of Split and Paste with Splice enabled, except that blank space is
pasted instead of the contents of the copy buffer. The default position for the
insertion is the location of the Current Time bar. If the Current Time bar intersects
a Region on a selected Track, then the Region is Split and blank space is inserted
at that point.

When an I-beam area selection is made, the amount of time inserted defaults to
the length of the selected area, starting at the beginning of the selection area.
When the insert point is selected with the Hand tool, the length of the insert time
defaults to 0 and must be manually entered in the Insert Time dialog box.

To Insert blank Time into one or more Tracks:

Select the insert point and track(s) you want to Insert Time into, then select
Insert Time from the Edit menu, or use keyboard shortcut CTRL+I . In the
Insert Time dialog box, modify the Amount of time to be inserted and the
Insert Position as necessary, and click OK.

Fades

A 10 millisecond fade is automatically generated at the beginning (fade-in) and
end (fade-out) of every region. These fades occur at the start and stop of any
recording, and also at the ends of any Cut or Split within a region. The duration of
the fade and its shape can be adjusted from the Region Editor dialog box (see page
17) or by dragging the inside edge of the fade area with the hand tool.

Right clicking in the fade area will pop up a menu to change the shape of the Fade-
in or Fade-out curve.
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Auto X-Fade (Crossfade)

When assembling chunks of audio, crossfading between two adjacent sections is
often employed to make the transition between them sound seamless. In razor
blade editing, we crossfade by making a diagonal cut across the tape, creating a
small portion of time where both sections are playing together. When crossfading
is active on the HDR24/96, a crossfade is automatically generated over the entire
overlapping area when one region is placed on top of another. The outgoing audio
fades down, while the incoming audio fades up.

Crossfade time on the HDR24/96 is adjustable from zero to nearly the entire
region length, with three different volume curve shapes. The crossfade occurs in
the area where the regions overlap, but, since regions and crossfade times can be
resized at any time, it’s easy to move the point at which the crossfade begins and
adjust the crossfade length for a smooth-sounding transition. Zooming in to the
crossfade area will help you to visualize what you’re hearing, but you should
always evaluate your edits by ear.

When performing musical
edits, it is important not
only to place the edit so
that musical timing is
correct, but to choose a
splice point so that the
splice is inaudible.
Experiment with
crossfade time and splice
position to obtain the
smoothest edits.

The AUTO X-FADE
button is located in the
Drag/Edit section of the
GUI tools panel. It toggles
between a crossfade
extending over the entire
overlapping area (AUTO

X-FADE On) and a fixed, 10 millisecond fade at the boundary of the two
overlapping regions (AUTO X-FADE Off). On or off, however, there will always be
a finite crossfade time when regions overlap unless you manually shrink it to zero.

The crossfade curves (rate of change of volume) come in three flavors - slow, fast
and linear. These can be selected from the Region Editor or from a pop-up menu
when right-clicking in the crossfade area. The crossfade is represented in the on-
screen waveform view by a red line which is easily visible when zooming in on a
splice.

See the note on the next page....
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Didgeridoo solo, for example) that are close to full scale amplitude, it’s possible
that they’ll attempt to sum to greater than full scale in the crossfade region. This
will both sound ugly and look ugly if you zoom in on it. Attack this problem by
changing the shape of the crossfade curve so that both sections aren’t near full
gain simultaneously.

Toggling the AUTO X-FADE function on or off will not affect any currently existing
crossfades. Crossfades become part of the region, so if a region spliced with a
crossfade is moved elsewhere, the crossfade will be carried along with it.

Volume Envelope (Node) Tool

The Node tool allows adjustment of the volume level within a region (which could
be the entire track). The pencil cursor is used to add nodes, or inflection points at
which the volume can be changed. Clicking on the volume envelope line with the
Node tool drops a node on the line. Nodes can be dragged along the volume
envelope line horizontally or vertically. By inserting nodes at the appropriate
places, you can create a mute, duck a note or word, or do a custom fade-in or fade-
out.

Holding the CTRL key with the Node tool active, changes the pencil to an eraser
for deleting nodes. When a node is deleted, the line straightens out to connect the
remaining nodes. When all nodes are deleted, you’re back to a straight line.

The first node you place in a region will be placed at unity gain (0 dB). You can
increase the audio level within the region by up to 6 dB, or lower it all the way
down to zero. While not a replacement for mix automation, it’s handy for muting
portions of a track, or adjusting the level of a punch-in so that it matches the rest
of the track.

There are nodes at the beginning and end of the region which cannot be deleted
(without them, there wouldn’t be anything to define the line), though they can be
dragged vertically to adjust the overall volume of the region.

Pressing the Shift  key when the Node tool is active turns the pencil cursor into
a double-headed vertical arrow. This tool allows you to drag the envelope line
vertically and parallel to itself. In reality, it’s dragging the pair of nodes that define
the line segment. If the envelope line is horizontal, Shift -clicking and dragging
the line adjusts the overall playback level of the track.

Note: Volume Envelope functions are interactive with the Envelope Active switch
in the Region Editor, and the View Envelopes setting in the Options menu. See
Page 19 for additional details.
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Region Editor
The Region Editor displays and defines (for the selected region) many of a region’s
attributes:

• Region name

• Start time

• End time

• Region length

• Whether the Volume Envelope is Active

• Whether Region Loop is enabled

• The region’s Fade-in and fadeout length

• The region’s Fade-in and fadeout curve shape

• Region Lock function

The Hand tool must be active in order to select regions to be edited with the
Region Editor. The Region Editor dialog box may be opened by:

• Double clicking (either right or left) on the region.

• Right-clicking on the region with the Hand tool and selecting Region Edit
from the pull-down menu which appears.

• Selecting the region with the Hand tool and using the keyboard shortcut
CTRL-E.

• Selecting Region Edit from the GUI top level menu Edit menu.

Once the Region Editor is open, you can select any region and the Region Editor
dialog box will update with data from the selected region.

Here’s what you’ll find in the Region Editor dialog box:

The following pages describe some of the details.



18 HDR 24/96

H
D

R
 2

4
/

9
6 Region Name

The name of a region is inherited from the track name at the time of the recording.
Regions created as a result of Capture, Import or Rendering operations also carry
the track name. If a track is renamed, subsequently created regions from that
track will inherit the new track name, but previously created regions are not
automatically renamed when the track name changes.

The name that appears in the upper left corner of the region block is updated when
the Name field in the Region Editor is updated, either by exiting the Name field or
clicking on another region or portion of the track area.

To edit the region name in the dialog box, double click on the Name field to
highlight it, then enter the new name.

NOTE: It is possible, and even pretty darn easy, to have more than one region with
the same name within a project, originating from the same or different audio
files. It is also possible to have a region with no name - i.e. left blank or erased on
purpose. There’s nothing functionally wrong with that as long as you have some
way of identifying the region when you need to do so. (listening to it works fine)
Naming is up to the recording engineer’s discretion. It’s good housekeeping prac-
tice to name regions uniquely for ease of editing, manipulation and reference
purposes, but unless your project involves a lot of editing, don’t go overboard.

Start time

This field shows the current time (SMPTE or BBT) of the left border of the region.
It’s dynamic. As you drag the region around or move its left boundary, the
displayed Start Time changes.

The time may be modified by editing the numbers in the field by any of the
standard methods - click and drag on the digits, or click to highlight and type in a
new number. When the entry is completed (press Enter  or click outside the time
field), the time field and the region start point are updated.

Any region’s starting edge may be modified (or trimmed) by dragging the edge in
or out with the Hand tool. This changes the starting time of the playback without
changing the audio file on disk. If the entire region is dragged to another time, the
start time follows along.

End Time

This time field works exactly like Start Time, but on the right-hand end of the
region. It is edited in exactly the same manner as Start Time.

Region Length

This time field displays the difference between the Start and End Times, saving
you the trouble of doing the arithmetic (we know you don’t have six fingers). It’s a
handy reference for checking length before performing region looping operations,
pasting into tight crevices, or for finding out if that 30 second spot is short
enough. Since this is an absolute time display, it remains in SMPTE format
regardless of the time format selected for other time displays. It can be edited in
exactly the same manner as Start Time. Editing the Region Length is functionally
equivalent to editing the End Time.
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Fade In and Fade Out

Fades, both Fade In and Fade Out, are tools that ramp the region volume from
zero amplitude up to unity gain amplitude (Fade In) or from unity gain down to
zero (Fade Out). Any time the fade length is greater than zero, the associated end
portion of the region (start, end, or both) will be displayed in the track area with a
different background color. This is the area over which the fade takes place. A red
line through that fade region represents the relative change in amplitude within
the fade region. The amplitude of the waveform follows the fade curve.

When the Hand tool is
placed on the inside
boundary of a fade region
and above the centerline of
the waveform display, the
“hand” changes to a “fade”
tool. This fade tool, which
looks like a quarter-circle,
is used to drag the edge of
the fade region to extend or
reduce the fade length.
Fade length can also be
adjusted “by the numbers”
by opening the Region

Editor window and editing the Fade time fields.

Obviously a fade time cannot be longer than the total region length, however a
fade can extend over the full length of the region. Fade In and Fade Out interact,
however, and one will push the other over to make room if they begin to overlap.

There are three selectable fade curves, which determine the rate of change of
volume over the fade time - slow, linear and fast. Your ears will tell you which one
works best for the application. Adjusting fades is best done interactively – listen,
adjust, listen again. You may find it convenient to set up a loop around the fade
region so that you can fine tune while listening.

Envelope Active

The Envelope ACTIVE button enables the volume changes you have made with
the Node tool. When Envelope View (Options\View Envelopes) and Envelope
ACTIVE are both turned on, the volume envelope is indicated by a yellow line in
the region, and the audio volume follows that envelope. If the ACTIVE button is
off, volume changes will not be heard.

The default envelope level is unity gain, at approximately 75% of the full region
height. Although there’s no calibration scale for the volume envelope, clicking on
the volume envelope line with the Envelope Node tool opens up a readout window,
showing the gain at that point. Full scale represents a gain of 6 dB, while the
bottom of the region is full off.

IMPORTANT: Even though View Envelopes is turned on, the volume envelope line
will only be displayed if the envelope has been made ACTIVE in the Region Editor
window or the Options pulldown menu. Conversely, if the volume envelope is AC-
TIVE in the Region Editor and View Envelopes is not turned on, the envelope will
not be visible in the region, however the volume will follow the (invisible) enve-
lope. Hence, it’s possible to have volume changes occurring within a region that
you don’t see on screen. If you work with volume envelopes, it’s best to leave
View Envelopes on.
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6 Region Looping

The Loop Region feature allows you to loop a specific portion of a region for
repetitive playback. This Loop function is usually used to create rhythmic
patterns, but may be used to create effects such delay repeats.

Region Loop mode is toggled either by clicking on the LOOP button in the Region
Editor window or by right-clicking in the region and selecting Loop from the pop-
up menu.

The length of the loop is equal to the region length displayed on the screen and in
the Region Edit window. Trim the length if necessary before looping the region.
When Loop mode is enabled, the region selected for looping may be stretched out
to repeat for any desired length of time. Regions can be looped in either direction
by pulling the region start or end points. The number of repeats need not be an
exact multiple of the loop length. It’s possible, for example, to have three and a
half loops.

Small tick marks on the region base and top delineate the start and end of each
repeated section within the extended loop. Multiple regions may be selected and
looped at one time, for up to 24 tracks of playback. If Loop is enabled by right-
clicking on one of a group of selected regions, they will all loop.

Region Lock

This Region Lock function disables editing or moving a region, but a locked region
can be copied. A selected region can be locked by right-clicking in the region and
selecting Lock from the pop-up menu, or by clicking on the LOCK button in the
Region Editor window The background of a locked region turns dark gray to
indicate its locked state.

Region Lock status is a toggle. Unlock a locked region by clicking on the LOCK
button in the Region Edit or uncheck Lock from the right-click pop-up menu.

NOTE: Locking does not prohibit recording over a region. If you want to protect a
region from recording, move or copy it into another track or virtual take.
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Editing Workshop
It’s time for a little hands-on editing practice. In real life, you’ll be editing songs,
drum loops, and rearranging words to make the talent say what you really want to
hear, but to get the hang of using the editing tools, we suggest working with
something a bit less subtle.

Here’s a helpful reminder. You’ll be jumping back and forth between the I-Beam
and Hand tools quite a bit. Practice using the T key to switch between the tools.
When using your eyes to help you edit, you don’t want to take them too far off the
area where you’re working.

Create a Practice Project

Open a new project, plug in a microphone, and record a track of yourself counting
from one to ten slowly. This will give you an audio file that’s well defined visually,
and one where you won’t be unsure whether you’ve located beat 1 or beat 2 in the
middle of a lengthy song.

A “Good Housekeeping” Detour - Playlists

Simple as it is, you’ve just recorded a basic track that you’re going to slice and
dice into oblivion. Although editing operations can be undone while you’re
working, the History List isn’t saved along with the Project. If you quit in the
middle of an editing session, you won’t be able to undo all of your edits when you
return to the Project at a later time.

Edits are saved in the Playlist – that’s what it’s for, and you can have multiple
playlists under a single project. Saving a playlist of your basic tracks before you
begin editing is a good habit to develop so that you can always get back to where
you started. So before you begin on your editing journey, save the Project, which
saves the Playlist along with it. Playlists take very little disk space, so don’t let
that deter you.

From the File menu, select Save Project. You’ve just preserved your magnum
opus together with the default-named Playlist 1. That’s your safety net. Now,
create a working Playlist by selecting Save Playlist As from the Playlist menu.
You’ll be prompted for a name. “Working” is convenient and descriptive. All the
edits you perform will be saved along with your Project under the Playlist name
you choose, but any time you want to return to the squeaky clean original version,
select Playlist Manager from the Playlist menu, and choose Playlist 1. We’ll do
this later on.

Once you get into creating multiple versions of a song, you’ll use the Playlist to
save the AM radio version with just two verses and a chorus, the dance club
version with the 128 bar drum and bass break, and the Adult Rock version with
one verse and three choruses.
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6 Split

By playing the track or using the Scrub tool, locate the space between “five” and
“six”. Click in the time bar to drop the Current Time marker onto that space. Now,
click the Split button in the Tools panel. You’ve just split the single region into
two pieces, one containing the count 1-5, the other 6-10.

To better visualize what you’ve done, using the Hand tool, click in portion of the
track to the left of the split line and you’ll see that half of the large region
highlighted. Similarly, clicking to the right of the split line will highlight that
portion. Note that each portion of the region now has the track name and take
number in its upper left corner. Congratulations! You’ve taken your first step
toward editing.

Splitting a Selected Area

But suppose we don’t want to manipulate just
the first or last part of a region, but rather, a
chunk in the middle. Locate the counts “three,
four” in the first region. Using the I-Beam tool,
select that area of the region. Click Split. The
original region is severed at the start and end
points of the selection. Now, you’ve further
divided the original region into more, smaller
regions so that you have:

[1,2] [3,4] [5] [6,7,8,9,10]

Now, each of those regions can be independently moved, copied, deleted, or cut up
into tiny pieces and spread over the pizza.

Crop

Cropping is the reciprocal of
splitting. It’s used to keep a
portion of a region and
discard the rest. With the
I-beam tool, select “Nine”
from the 6-10 region. Click
the Crop button or use the
shortcut CTRL+T;
everything but “Nine” in that

region will be deleted, leaving just that one lonely number.

Undo and Redo

That crop job didn’t leave us with much to work with, so let’s put that region back
together again. From the Edit pulldown menu, select Undo Crop (“Crop” will
change from operation to operation to remind you of which operation you’re about
to undo) or use the shortcut CTRL+Z. See? Non-destructive editing!

The Undo command and CTRL+Z always undoes the last operation. Undo again
and you’ll undo the operation before that (Split). Since the previous operation we
performed before the Crop was a Split, pull down the Edit menu again and you’ll
see Undo Split.

You’ll also see Redo Crop, so if you decided that you really wanted it cropped, you
can crop it again, right in the same place. Of course if you wanted to crop it in a
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different place instead, you’ll have to mark and crop again. The keyboard shortcut
to Redo is CTRL+Shift+Z .

Play with this a bit until you get the feel of it. When you are done, restore the 6-10
region intact so you’ll have something to work on for the next exercise.

Cut and Splice

With the Hand tool, click on the “Three Four” region to select it. Select Cut from
the pulldown Edit menu, click the Cut button or use the keyboard shortcut
CTRL+X. Poof! The region disappears. The selected region is not gone forever,
mind you — it’s just hiding on the clipboard.

With the I-Beam tool, select the area containing “Seven” from its region and Cut.
“Seven” disappears and the beginning and end portions remain as separate,
disconnected regions.

In the tape-editing world, the cutting we just did would also result in three pieces;
the piece on the supply reel, the piece on the take-up reel, and the piece left in the
splicing block. Obviously, the leading and trailing pieces then have to be attached,
or spliced - tape decks aren’t good at playing broken tape. The HDR24/96 doesn’t
mind, however, if what you want is a gap rather than joining the sections.

In the Splice mode, the HDR24/96 behaves like a human tape editor with a
splicing block, automatically connecting the leading and trailing pieces when
you’ve cut something out in between:

Put “Seven” back in place using the Undo function. While you’re at it, put “Three,
Four” back as well.

Click on SPLICE in the Tools panel to engage the Splice mode

With the I-Beam tool, select “Seven”. Cut it. Note that the “seven” portion of the
region disappears, and the remainder of the region slides to the left to fill the gap.
Now we have “six-eight-nine-ten”. If there had been more regions on the track to
the right of this one, they would have moved also.

The Cut and Splice process works across multiple tracks, so you can remove a
verse from a song with a single operation, just as if you were slicing across a
piece of 2” tape. When we get into copying and pasting, we’ll show you how.

See what’s happening here? The HDR24/96 has freed your audio from the
constraints of time and tracks, and your old tape machine has just become a, well,
um ... “Drop anchor!”

Copy & Paste

Pieces are always copied to the clipboard and pasted from the clipboard, just like
a word processor. We’ve seen how the Splice mode takes up the space where
we’ve cut out an area. Here, we’ll see how the Splice mode affects the track when
you paste something new into it.

Pasting with Splicing

Get back to a known version of the “count to ten” track by repeatedly
Undoing until you’re back to the four regions we had before we started
cropping. [1,2] [3,4] [5] [6,7,8,9,10]

With the hand tool, select the [3,4] region. Click Copy. Although nothing
appears to have changed, behind the scenes, that region was copied onto the
invisible clipboard. Choose a track you’d like to copy that region to and click
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6 on its track number button. Drag the current time bar to the point where you

want the copy to appear. Click Paste - the selection you just copied appears
on the chosen track, starting where you positioned the current time bar.

If Splice is on, turn it off by clicking on the Splice button.

Chop a hole in the counting track by selecting the [5] region with the Hand
tool, and clicking on Cut.

With the I-Beam tool, select an area starting between “three” and “four”, and
ending between “six” and “seven”, spanning the blank space left when we cut
out “five”. Click Copy. Click on the track where you pasted [5], set the time
bar a bit past the end of that region, and click Paste. The selection you just
copied appears there, complete with blank space.

Now we have a track with three regions: [5], a portion of the [3,4] region
containing only “four”, and a portion of the [6,7,8,9,10] region containing only
“six”, and including the original space where [5] was removed.

Just to refresh your dragging skills, using the Hand tool, grab the [5] region
and drag it to the right, just past the end of the “six” region on the track.

Now select Splice. Move the current time pointer to the blank space just
before the [5] region. That selection with the gap in the middle is still on the
clipboard because we haven’t replaced it with anything yet. Click Paste.

The [5] region moved later in time to accommodate the pasted selection. This
is the equivalent of cutting the tape and inserting a new section.

Use this principle to repeat the chorus of a song. Here’s how to do it:

Select the chorus. By dragging the I-Beam tool along the time bar rather than
over just one track, you’ll select all the tracks at once. Copy the selection to
the clipboard.

Park the Current Time pointer where you want the duplicated chorus to start.
All of the tracks should still be selected since your all-tracks area selection is
still active. Turn Splice on.

Click Paste. The copy of the chorus is dropped into the tracks where it
belongs. Because all tracks were selected and Splice was active, all the
tracks moved over by the length of the chorus, so the other tracks didn’t get
out of synchronization.

Reality is a bit more complicated than that, because you’ll need to trim and
nudge to get the timing right on, but the more you do, the easier it gets.

Pasting without Splicing

Now, deselect Splice and let’s take a look at pasting without splicing.

Sometimes you don’t want to insert a new section, you want to replace. When
you Paste with the Splice mode off, the selection or region is just plopped
right smack on top of the region that’s already there (even if it’s blank space).
The track doesn’t slide out of the way to make room for the new section. You
haven’t overwritten anything – the underlying audio is still there, but the
HDR24/96 plays what’s on top, so you’ll hear the track with the new section
rather than the old one.

Undo your edits far enough back so that you have all the numbers in order
again. Select the area over “two” using the I-Beam tool. Copy it to the
clipboard. Now place the current time pointer just ahead of “four” and Paste.
Now you’ll hear the count 1, 2, 3, 2, 5, . . .
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Adjusting a Region’s Length

The locations in time of a region’s outer edges can be changed by positioning the
cursor over a region’s edge. The hand becomes a bi-directional arrow with which
you can drag the edge of the region. Try this:

With the Hand tool, drag a region’s leading edge to the right; the region starts at a
later time, shortening the audio at the beginning, but leaving the rest of the region
undisturbed. Drag the left edge to the left and the region grows, adding audio from
its corresponding audio file ... as if by magic. This is a great shortcut for editing
the endpoints of regions, without having to select and delete areas.

Crossfading between Regions

Crossfades are simply two overlapping fades; the audio in the leading region fades
out while the trailing region fades in. See page 15 for details on how they work.
Very short crossfades over a splice can work well to smooth the transition. Long
ones can sometimes sound very strange, or may be just the effect you’re after (for
instance if you’re blending narration in over a music bed). Listen to your edits and
make a judgement.

In the Tools panel, select AUTO X-FADE. Select a region and CTRL-drag it to the
right, making a copy. Position the copy so that it’s not touching the original. Drag
the start of the copy to the left, back over the original version. Notice the red fade
lines automatically reaching from the original region’s trailing edge to the new
region’s leading edge. The greater the overlap area, the longer the crossfade.

Right-clicking in the crossfade area brings up a variety of choices for the slope of
the fade-in and fade-out. Try playing a few back; notice how the underlying
waveform display reflects the actual amplitude changes.

Note: With AUTO X-FADE disabled, overlapping regions do not fade into each
other; rather, one region lies “under” the other and any “overlapping” audio is not
played.



26 HDR 24/96

H
D

R
 2

4
/

9
6 Extra Credit

Before you take off to create a musical collage with your new editing skills, try
one more exercise. By now you should know where to find all the buttons and
tools. This will help you to get comfortable with them.

Return to your original raw “count to ten” track by opening Playlist 1. You did
follow the instructions and save it, didn’t you? Good! Select Playlist Manager
from the Playlist menu and double-click on Playlist 1. That should get you back to
a whole track. We’re going to do is change that 1-to-10 count into a different
arrangement of numbers, just as you might rearrange portions of a song, or words
in a speech.

Using the I-Beam tool and the SPLIT button, divide the track up into individual
regions, one spoken number to a region. Place the I-Beam on the track in a space
between numbers and click SPLIT. Do this throughout the track. Then, using the
Region Editor, rename each region so you can identify them visually. The quick
way to do this is to double-click on a region using the Hand tool. This will pop
open the Region Editor, where you can type in a new name. Once the Region
Editor dialog box is opened, a single click on any other region with the Hand tool
will pull that region up in the Editor.

Now, using the Hand
tool, copy some
numbers to a new
track, or if you choose,
another virtual take
under the track with
the original recording.
Holding the CTRL key
while dragging a
region will copy it,
simply dragging it

without the CTRL key will move it. Try pulling together the regions to make your
telephone number. Need to call Mackie for help? Here’s ours:

Pretty cool, huh? Many thanks to Sheri Fleming for speaking into our microphone.

Now, let’s get even more creative. Create a new track with the numbers counting
down rather than up. Turn on SNAP and you’ll see that the regions butt right up
against each other as you move them into place.
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Tighten up the edits if you wish, by cutting out some of the “dead air” and making
the pauses between numbers more natural. In short order, you’ll have this sounding
at least as good as the automated telephone directory assistance.

So now you have the perfectly edited take and you want to make sure it stays that
way if you copy it into other places in your song. Right now it’s a bunch of pieces
that can come unglued if you’re not careful about handling them. Here’s a look at
two more HDR24/96 functions which are not really editing tools, but you’ll want to
use to solidify your editing work. These are Rendering and dragging entries from the
Regions List into tracks.

Render Tracks

Rendering is the equivalent of playing the audio as edited and recording a new track
which is all in one piece. Once the “Backwards” track is rendered, you can place it
anywhere (even in another project) with all the edits intact. A rendered track
inherits the name of the track at the time of rendering, so if you haven’t renamed
your tracks yet, this is a good time to do so.

Rendering can be performed on the entire project including all the tracks from start
to end, or on individually selected tracks over a specific time range. Let’s render our
two cut up tracks.

First, block out the area to be rendered. Use the I-Beam tool in the time bar (above
the tracks) to select an area to include both tracks. All the tracks will be selected,
so deselect all but the two you wish to render. Select Render Tracks from the Edit
menu. Click OK.

When the
Rendering
operation is
complete, open
the Regions List.
You’ll find your
rendered tracks
there.

Dragging Regions Into Tracks

To bring those rendered tracks into your project, all you
need to do is click on their names in the Regions List and
drag them into the track area. Try it. Drag them to two
empty tracks in your project. You’ll see that they have no
breaks in them, and they sound exactly like the cut and
spliced versions.

Okay, now you’re an editor. Go create some music.




